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As part of an effort to improve its product lines, we periodically release revisions of its software and hardware. Therefore, some
functions described in this document might not be supported by all versions of the software or hardware currently in use. The
product release notes provide the most up-to-date information on product features.

Purpose
This manual describes how to install, configure, and administer DD Virtual Edition (DDVE) systems.

Audience
This manual is intended for use by both system administrators and general users of DD Virtual Edition.

Related documentation
The following publications and websites provide additional information:

● DD Operating System Release Notes
● DD Operating System Initial Configuration Guide

This manual explains configuration steps that are common to hardware and virtual DD systems.

● DD Operating System OS Command Reference Guide

This manual explains how to administer DD systems from the command line.

● DD Operating System OS Administration Guide

This manual explains how to administer DD systems with the System Manager graphical user interface.

● DD Boost for OpenStorage Administration Guide

This manual explains how to use the DD Boost protocol for data transfer between backup software and DD systems.

● Avamar, DD and NetWorker Compatibility Guide: http://compatibilityguide.emc.com:8080/CompGuideApp/

This website lists Avamar and NetWorker software support for DDVE.

Where to get help
We support, product, and licensing information can be obtained as follows:

Product
information

For documentation, release notes, software updates, or information about products, go to Online Support
at https://support.emc.com.

Technical
support

For technical support of this release of DDVE, go to Online Support at https://support.emc.com.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall quality of the user publications. Send
your opinions of this document to DPAD.Doc.Feedback@emc.com.

Preface
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Introducing DDVE
This chapter includes the following topics:

Topics:

• Introducing DDVE
• DDVE features

Introducing DDVE
DD Virtual Edition (DDVE) is a software-only protection storage appliance: a virtual deduplication appliance that provides data
protection for entry, enterprise and service provider environments. Like any DD system, DDVE is always paired with backup
software.

DDVE runs the DD Operating System (DD OS), and includes the DD System Manager graphical user interface (GUI) and the DD
OS command line interface (CLI) for performing system operations.

DDVE includes the following features:

● High-speed, variable length deduplication for a 10 to 30 times reduction in storage requirements
● Unparalleled data integrity to ensure reliable recovery, and seamless integration with leading backup and archiving

applications
● DD Boost to speed backups by 50 percent
● DD Encryption for enhanced security of data
● DD Replicator for network efficient replication that enables faster time-to-DR readiness

DDVE runs on two types of platforms:

● On premises, DDVE supports VMware, Hyper-V, KVM, and VxRail.
● In the cloud, DDVE also runs in the Amazon Web Services (AWS) (cloud and gov cloud), Azure (cloud and gov cloud),

VMware Cloud (VMC) on AWS cloud platforms, and Google Cloud Platform (GCP).

For more information about the features and capabilities of DD systems (both physical and virtual), see the DD Operating
System Administration Guide.

DDVE features
Resource configurations depend on your DDVE configuration. For features for cloud configurations within the admin guide for
your specific cloud provider, see .
● Up to 500 GB (evaluation version only)
● Up to 8 TB
● Up to 16 TB
● Up to 32 TB
● Up to 48 TB
● Up to 64 TB
● Up to 96 TB

DDVE capacity is available in 1 TB increments starting at 1 TB, and up to 96 TB. The following sections list supported DD
protocols and features in DDVE.

Supported DD protocols
● CIFS
● NFS
● DD Boost (DD Boost) over IP
● DD Boost (DD Boost) FS

1
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Supported DD features
● DD Boost managed file replication (MFR)
● Encryption
● DD System Manager GUI for DDVE management
● Secure multitenancy (SMT) with Network Isolation Support in 6.0
● DD Cloud Tier (supported in 16 TB, 64 TB, and 96 TB configurations)
● Hadoop Application Agent
● KMIP
● More restricted IPtables settings
● Managed file replication and MTree replication
● Instant access (supported on 16 TB and larger configurations only)
● Retention Lock Governance Edition is supported on DDVE (both on premises and in the cloud)

The DD OS Administration Guide, DD Boost OST Guide, and DD Boost for Partner Integration Administration Guide provide
additional information about the supported protocols and features.

Unsupported DD features
● DD Boost over FC
● Extended retention
● DD High Availability (HA)--however, VMware and Hyper-V HA are supported
● NDMP
● VTL
● Collection replication
● Directory replication
● Instant access (not supported on configurations smaller than 16 TB)
● Retention Lock Compliance Edition
● Net aggregation

DD OS commands that are related to these unsupported features, and commands for hardware features that are not applicable
to a virtual machine, are not supported on the DDVE platform.
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Deploying DDVE
This chapter includes the following topics:

Topics:

• Managing DDVE
• Supported virtual environments
• Provisioning physical storage
• Managing SSD cache tiers
• Configuration requirements for DD Cloud Tier support
• Installing DDVE on premises
• Defining the DD system information for your site
• Deploying DDVE on KVM hypervisor
• Configuring other resources for DDVE on KVM
• Deploying the DDVE on the KVM Hypervisor

Managing DDVE
Use the VMware vSphere client software, the VMware vSphere Web client, or Hyper-V Manager to install a DDVE instance and
define its virtual hardware, including CPUs, memory, network interfaces, and virtual disks.

The DD System Manager provides a configuration wizard to guide you through the steps required to configure DD OS after the
virtual appliance is installed.

Once DDVE is configured and running, you can access the system console to run DD OS commands by using the VMware
vSphere Web client or Hyper-V Manager. You can also administer the DDVE by using a terminal emulator or ssh command to
use the CLI.

The default login credentials for the DDVE instance are:

● Username: sysadmin
● Password: changeme or the password specified during deployment

NOTE: The system sends an alert if an RSA DPM client certificate is within 15 days of expiring.

Supported virtual environments
DDVE is supported in the following virtual environments:

● Microsoft Windows Server 2012 R2 with Hyper-V.
● KVM hypervisor on supported Linux distributions
● VMware ESXi servers, either standalone or managed by VMware vCenter, versions 5.5, 6.0, and 6.5 with the corresponding

versions of the VMware vSphere client application.

NOTE: DDVE supports virtual hardware versions of virtual machines up to the latest version of the ESXi in use, and

minimum of version 10. Consult VMware latest documentation for any virtual hardware version upgrades.

Table 2. Supported Virtual Hardware 

ESXi Version Up to Virtual Hardware
version

ESXi 6.5 13

ESXi 6.0 11

ESXi 5.5 10

2
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NOTE: The OpenVMTools are pre-installed on the DDVE image. When you update the DD OS software on the DDVE from

within the DD OS environment, any necessary updates to the OpenVMTools are installed automatically. It is not possible to

update OpenVMTools on the virtual machine from outside DD OS.

The hypervisor user needs read-only privileges on the data center object where the server or cluster hosting the DDVE instance
resides.

For information about compatibility with VMware or Microsoft products, visit the support portal at https://support.emc.com.

Provisioning physical storage
You can provision storage on an ESXi or Windows Hyper-V server to host the DDVE instance.

NOTE: Ensure that the disks provisioned in VMware are configured as "Independent Persistent Disks."

Raw physical storage capacity requirements

The following table shows the raw storage capacity required to provide the net usable capacity. For raw capacities not listed,
use the same raw capacity in TiB as the usable capacity.

For example:

● To net 40 TB usable capacity, provision 40 TiB.
● For 5 TB capacity with 8 TB configuration, provision 5 TiB.

NOTE: The capacity in vCenter or Hyper-V manager is listed in TiB. When you create a 1 TB virtual disk in vCenter, a

storage capacity of 1 TiB is allocated.

This table does not apply to configurations with DD Cloud Tier.

Table 3. Raw physical capacity requirements 

Usable Capacity (TB) Raw Capacity (GiB) at each configuration

8 16 32 48 64 96

0.5 622 620 632 694 752 846

1 1116 1114 1126 1188 1245 1340

2 2101 2100 2112 2174 2232 2326

3 3072 3072 3098 3161 3218 3312

4 4096 4096 4096 4148 4205 4299

5 5120 5120 5120 5120 5191 5286

6 6144 6144 6144 6144 6144 6272

7 7168 7168 7168 7168 7168 7259

8 8192 8192 8192 8192 8245

9 9216 9216 9216 9216 9216

Table 4. Conversions for raw physical capacity  

GiB TB

1 0.001074

TB TiB

1 0.909495
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Managing SSD cache tiers
The SSD cache tier for DDVE systems uses flash technology to create cache tiers for file system metadata. The SSD cache is a
low latency, high input/output operations per second (IOPS) cache to accelerate metadata and data access.

NOTE: The minimum software version required for HyperV and KVM is DD OS 6.2.x.x.

The SSD cache tier provides the SSD cache storage for the file system. Caching the file system metadata on SSDs improves I/O
performance for both traditional and random workloads.

When the cache tier is first created, a file system restart is required if the cache tier is added when the file system is running.
You can add cache to a live system without disabling the file system. If the file system does not been exist or if the file system is
not enabled, creating or enabling the file system after adding the cache tier activates the SSD cache.

NOTE:

● If encryption is enabled for the active tier, data cache and DM cache are not enabled.

● When the remaining number of spare blocks gets close to zero, the SSD enters a read-only condition. DD OS treats the

drive as read-only cache and sends an alert.

SSD cache tier requirements

Review the SSD requirements for your specific DDVE model. Note that SSD cache tier is not supported for configurations less
than 16 TB.

Table 5. Supported SSD models and requirements 

DDVE Model SSD Requirement

DDVE 16 TB 160 GB

DDVE 32 TB 320 GB

DDVE 48 TB 480 GB

DDVE 64 TB 640 GB

DDVE 96 TB 960 GB

Best practices and limitations for cache tier storage

You should be aware of the following best practices and limitations when adding storage to the cache tier:

● Adding storage to the cache tier requires a CAPACITY license in the system.
● Add only SSD type disks to the cache tier. If the device is not recognized as an SSD disk, use the force option in the

storage add tier cache CLI command. For example, storage add tier cache <dev> force.

● You must add at least a 100 GB disk to the cache tier.
● If the tier is under provisioned when the file system is enabled, you must add the required cache capacity.
● If the tier is over provisioned, adding the cache tier storage fails.

SSD cache tier considerations

Be aware of the following best practices and limitations for SSD cache tiers:

● When the number of spare blocks remaining gets close to zero, the SSD enters a read-only condition and DD OS treats the
drive as read-only cache and sends an alert.

● When SSDs are deployed within a controller, the SSDs are treated as internal root drives. They appear as enclosure 1 in the
output of the storage show all command.

● You can manage individual SSDs with the disk command the same way HDDs are managed.

● You can run the storage add tier cache command to add an individual SSD or an SSD enclosure to the SSD cache
tier.
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● The SSD cache tier space is managed automatically. The file system draws the required storage from the SSD cache tier and
shares it among its clients.

Using the DAT tool to meet IOPS requirements for the SSD cache
tier

Prerequisites

We recommend that you run the DAT tool before you create a file system and after you add SSD to the cache tier.

About this task

NOTE: Running the DAT tool after you create the file system does not provide the expected results. If the disks are in use

by the file system, DAT performs read-only test.

Steps

1. Start an SSD cache benchmark test only.

In the following example, dev3 is a cache disk on a 16 TB DDVE instance.

disk benchmark start cache dev3
This will take about 5 minutes to complete.
    Are you sure? (yes|no) [no]: yes

ok, proceeding.
Checking devices, please wait.
Benchmark test 1 started, use 'disk benchmark watch' to monitor its progress.

Results:
disk benchmark show
Last benchmark test 1 was completed.
Devices:             dev3 dev3 dev3 dev3 dev3 dev3
Start Time:          2018/06/22 17:23:29
Duration (hh:mm:ss): 00:04:55

Cache Write   Cache Read   Cache Write          Cache Read
Random IOPS   Random IOPS  Random Latency (ms)  Random Latency (ms)
------------  ------------ -------------------  -------------------
          102         24092              6.75                 0.98
------------  ------------ -------------------  -------------------
            This set of devices is suitable for use in a 16 TiB file system.

2. Start a test of the SSD cache test and the data disk.

In the following example, dev3 is a cache disk and dev4 and dev5 are data disks on a 16 TB DDVE instance.

disk benchmark start dev4+dev5 cache dev3
This will take about 10 minutes to complete.
    Are you sure? (yes|no) [no]: yes

ok, proceeding.

Checking devices, please wait.
Benchmark test 30 started, use 'disk benchmark watch' to monitor its progress.

Results:
disk benchmark show
 
Checking devices, please wait.
Benchmark test 30 was completed.
Devices:             dev4+dev5 dev3+dev3 dev3+dev3 dev3+dev3 dev3+dev3 dev3+dev3 
dev3+dev3
Start Time:          2018/06/22 15:46:01
Duration (hh:mm:ss): 00:09:40

Sequential                Read Random       Read Random         vNVRAM
Throughput (MiB/s)        IOPS              Latency (ms)        Write IOPS
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------------------        -----------       ------------        ----------
             2322               1244               5.50               n/a
------------------        -----------       ------------        ----------

Cache Write   Cache Read   Cache Write          Cache Read 
Random IOPS   Random IOPS  Random Latency (ms)  Random Latency (ms)
------------  ------------ -------------------  -------------------
        102         24544              6.79                 0.99
------------  ------------ -------------------  -------------------
This set of devices is suitable for use in a 16 TiB file system.

Using the DD System Manager to manage SSD cache tiers

You can add or remove SSD cache tier devices using the DD System Manager.

About this task

NOTE: To add devices to a cache tier for DDVE instances on a KVM Hypervisor, you must use the CLI command storage
add tier cache force dev[ ].

Steps

● Use one of the following methods to add or remove a cache tier device on a DDVE instance:
○ Launch the Configuration wizard from the DD System Manager when you create the file system: Select Maintenance >

System > Configure System > Configuration Wizard > File System > Configure Cache .
○ Launch the wizard from the DD System Manager Start page: Select Data Management > File System > Create >

Create File System > Configure Cache Tier.
○ Launch the wizard from the DD System Manager Hardware page: Select Hardware > Storage > Overview > Cache

Tier > Configure > Configure Cache Tier.

Using the CLI to manage SSD cache tiers

Use the following CLI commands to manage the SSD cache tier for DDVE instances.

Table 6. SSD cache tier CLI commands 

Command Description

# storage add tier cache dev3 Adds storage to the cache tier.

# storage add tier cache dev3

Checking storage requirements...done

Adding dev3 to the cache tier...done

Updating system information...done

dev3 successfully added to the cache tier.

# storage remove dev3 Removes storage from the cache tier.

# storage remove dev3

Removing dev3...done

Updating system information...done

dev3 successfully removed.
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Table 6. SSD cache tier CLI commands (continued)

Command Description

# storage show tier cache Displays the storage configured for cache tier.

# storage show  tier cache
Cache tier details:
Device   Device   Device   
Group             Size     
------   ------   ---------
dg0      3        320.0 GiB
------   ------   ---------
 
Spindle   Devices   Count   Total Size
Group                                 
-------   -------   -----   ----------
1         3         1       320.0 GiB 
-------   -------   -----   ----------
 
Current cache tier size: 0.3 TiB

Storage addable devices:
Device      Device   Device 
Type                 Size   

Configuration requirements for DD Cloud Tier support
Ensure that each DDVE instance in your system meets the resource requirements for DD Cloud Tier support.

To configure DD Cloud Tier for DDVE instances, see the Administration Guide.

Table 7. DDVE resource reservations 

Configuration CPU Memory
(GiB)

Minimum
Metadata Tier
Size (GiB)

Metadata Tier
Throughput (MB/S)

Metadata Tier
IOPS

Metadata Tier
Latency (ms)

16 TB 4 32 500 160 640 14

64 TB 8 60 500 640 2560 14

96 TB 8 80 500 960 3200 14

The minimum metadata size in DDVE resource reservations on page 14 is a hard limit. It is recommended that you start with 1
TiB metadata tier and expand in 1 TiB increments.

DD Cloud Tier metadata size for DDVE on page 14 lists the recommended metadata (MD) tier sizes for each cloud unit (CU)
size range. The CU (TiB) size includes two cloud units.

NOTE: Disks that you add from the host side are specified in TiB units (not TB). 1 TiB is equal to 1.02 TB (see Conversions

for raw physical capacity on page 10).

Table 8. DD Cloud Tier metadata size for DDVE 

CU Size
(TiB)

1-16 16-32 32-48 48-64 64-80 80-96 96-112 112-128 128-144 144-160 160-176 176-192

MD
Size
(TiB)

1 2 3 4 5 6 7 8 9 10 11 12

The Dell EMC Administration Guide provides more DD Cloud Tier information.
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Installing DDVE on premises
DDVE can run on premises or in the public cloud. On premises, DDVE supports VMware, Hyper-V, VxRail, and KVM platforms.
The DD OS Administration Guide provides more information about the features and capabilities of DD physical and virtual
systems.

Downloading the DDVE software

DDVE software is packaged as a ZIP file that contains a virtual machine template file (OVA for VMware environments or VHD
for Microsoft environments).

Prerequisites

DDVE requires a minimum of 760 GiB for configurations of 64 TB, Cloud 64 TB, 96 TB, and cloud 96 TB. For 96 TB, the
minimum size of the first data disk is 500 GiB.

For smaller configurations, DDVE requires a minimum of 460 GiB of available storage to deploy, as follows:

● System disk: 250 GiB
● vNVRAM disk: 10 GiB
● First data disk: 200 GiB

About this task

All capacity configurations are available from the same zip file.

The 500 GiB evaluation version is available from the Trial Download page.

Steps

1. Go to Dell EMC Online Support.

2. Download the ZIP file that is appropriate for your environment.

Installing DDVE on a VMware ESXi Server

About this task

The hypervisor documentation provides additional details.

NOTE: You can also use ovftool to install the software from the command line. For help, see the VMware

documentation.

Steps

1. Use the vSphere Client to log in to the ESXi server.

2. Launch the virtual machine deployment wizard. Step through the wizard clicking Next to proceed at each step.

3. Select local file or network location from which to deploy the download file.

4. Review the details of the VM where the file will be deployed.

5. Review and accept the End User License Agreement (EULA).

6. Enter a name for the DDVE virtual machine.

This name identifies the virtual machine on the VMware server. It does not become a host name on your LAN.

7. Select a dedicated datastore where the DDVE instance will reside.

Dell EMC recommends that you use a datastore that is not shared by other virtual machines.

8. Review the summary and click Finish.

Next steps

Confiture the virtual machine. See Initial virtual machine configuration on page 20.

Deploying DDVE 15

https://www.emc.com/products-solutions/trial-software-download/data-domain-virtual-edition.htm


Installing DDVE on a VMware vCenter Server

About this task

The hypervisor documentation provides additional details.

Steps

1. Use the vSphere Client to log in to the vCenter server.

2. Launch the virtual machine deployment wizard. Step through the wizard clicking Next to proceed at each step.

3. Select local file or network location from which to deploy the download file.

4. Review the details of the VM where the file will be deployed.

5. Review and accept the End User License Agreement (EULA).

6. Enter a name for the DDVE virtual machine.

This name identifies the virtual machine on the VMware server. It does not become a host name on your LAN.

7. Select the inventory location or data center to assign the DDVE instance to a host or cluster.

8. Select a host or cluster in the specified inventory location or data center where the DDVE instance will reside.

9. Select a dedicated datastore where the DDVE instance will reside.

Dell EMC recommends that you use a datastore that is not shared by other virtual machines.

10. Select the format for the virtual disks.

Dell EMC recommends Thick Provision Lazy Zeroed to provide the best balance of performance and deployment time. Thick
Provision Eager Zeroed provides the best performance, but takes a long time to deploy.

11. Review the summary and click Finish.

Next steps

Confiture the virtual machine. See Initial virtual machine configuration on page 20.

Installing DDVE in a Microsoft environment

You can install DDVE on a Microsoft Windows Server 2012 R2 or Windows Server 2016 with Hyper-V Server by creating a virtual
machine or by using a PowerShell script.

Installing DDVE by creating a virtual machine

Install DDVE on a Microsoft Windows Server 2012 R2 or Windows Server 2016 with Hyper-V Server by creating a virtual
machine.

About this task

The hypervisor documentation provides additional details.

Steps

1. Provide the user name and password to log into the Windows server.

2. Launch the Hyper-V deployment wizard, clicking Next to proceed.

3. Specify a name for the DDVE virtual machine.

This name identifies the virtual machine on the Windows server. It does not become a host name on your LAN.

4. Specify the amount of memory to assign to the virtual machine.

5. Connect the DDVE virtual machine to the Hyper-V networking switch.

6. Select the VHD file that contains the DDVE instance.

Next steps

Configure the virtual machine. See Initial virtual machine configuration on page 20.
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Installing DDVE using a PowerShell script for Hyper-V Manager

Install DDVE on a Microsoft Windows Server 2012 R2 or Windows Server 2016 using a PowerShell script for Hyper-V Manager.

About this task

Syntax: C:\ddve-hyperv-0.6000.11.0-524942\ddve-installer.ps1 [-VMName] <String> [-
Configuration] <String> [[-VirtualMachinePath] <String>] [[-VirtualHardDiskPath] <String>]
[-Force] [<CommonParameters>]
Example: C:\PS>ddve-installer.ps1 -VMName DDVE -Configuration 8TB -VirtualMachinePath C:\DDVE
-VirtualHardDiskPath C:\DDVE

Table 9. Hyper-V Installation for Windows Powershell Script 

Parameter Description

-VMName <String> Specify the name of DDVE virtual machine

-Configuration <String> Specify the configuration of the DDVE. This parameter accepts one of these
values 8TB, 16TB, 32TB, 48TB, 64TB, 96TB.

-VirtualMachinePath <String> Specify the directory to store files for the DDVE virtual machine. This
parameter is optional and wildcard characters are supported for this
parameter value. If this parameter were not specified in command line,
Hyper-V setting would be used for this parameter value.

-VirtualHardDiskPath <String> Specify the directory to store virtual hard disks for the DDVE. This
parameter is optional and wildcard characters are supported for this
parameter value. If this parameter were not specified in command line,
Hyper-V setting would be used for this parameter value.

-Force [<SwitchParameter>]

<CommonParameters> This cmdlet supports the common parameters: Verbose,
Debug, ErrorAction, ErrorVariable, WarningAction,
WarningVariable, OutBuffer, PipelineVariable, and
OutVariable. For more information, see about_CommonParameters,
available from the Microsoft website.

See ddve-installer-help.txt for additional information.

Installing DDVE using a PowerShell script for Microsoft System Center

Install DDVE on a Microsoft Windows Server 2012 R2 or Windows Server 2016 with Hyper-V Server using PowerShell script for
Microsoft System Center.

About this task

Syntax: C:\ddve-hyperv-0.6000.11.0-524942\ddve-installer-sc.ps1 [-VMName] <String> [-
Configuration] <String> [-SCVMMServer] <String> [-SCVMHost] <String> [-SCVMNetwork]
<String> [[-VirtualMachinePath] <String>] [[-VirtualHardDiskPath] <String>] [[-
NetworkAdapterCount] <Int32>] [[-IPAddress] <String>] [[-Gateway] <String>] [[-Netmask]
<String>] [[-DnsServer1] <String>] [[-DnsServer2] <String>] [<CommonParameters>]
Example: C:\PS>.\ddve-installer-sc.ps1 -VMName DDVE -Configuration -SCVMMServer localhost -
SCVMHost osdev-ucs30d -SCVMNetwork mktest-vmnet -NetworkAdapterCount 3

Table 10. Hyper-V Installation for Windows Powershell Script for MS system Center 

Parameter Description

-VMName <String> Specify the name of DDVE virtual machine.

-Configuration <String> Specify the configuration of the DDVE. This parameter
accepts one of these values 8TB, 16TB, 32TB, 48TB, 64TB,
96TB, Cloud16TB, Cloud64TB, Cloud96TB.
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Table 10. Hyper-V Installation for Windows Powershell Script for MS system Center (continued)

Parameter Description

-SCVMMServer <String> Specify the system center VMM server name.

-SCVMHost <String> Specify the Hyper-V host where DDVE will be deployed.

-SCVMNetwork <<String> Specify a VM Network.

-VirtualMachineHostname <String> Specify the hostname of the DDVE virtual machine. This
parameter is optional and wildcard characters are supported
for this parameter value. If this parameter is not specified
in command line, localhost would be used for this parameter
value.

-VirtualMachinePath <String> Specify the directory to store files for the DDVE virtual
machine. The VirtualMachinePath folder must exist on host
SCVMHost. If this parameter is not specified in command line,
Hyper-V setting would be used for this parameter value.

-VirtualHardDiskPath <<String> Specify the directory to store virtual hard disks for the DDVE.
The VirtualHardDiskPath folder must exist on host SCVMHost.
If this parameter is not specified in command line, Hyper-V
setting would be used for this parameter value.

-NetworkAdapterCount <Int32> Specify the number of network adapters to be added to
DDVE. If this parameter is not specified, 2 networks adapters
are added. This parameter accepts value in range 1 to 8.

-IPAddress <String> Specify IP address.

-Gateway <String> Specify gateway IP address.

-Netmask <String> Specify netmask.

-DnsServer1 <String> Specify first DNS server IP address.

-DnsServer2 <String> Specify second DNS server IP address.

<CommonParameters> This cmdlet supports the common parameters:
Verbose, Debug, ErrorAction, ErrorVariable,
WarningAction, WarningVariable, OutBuffer,
PipelineVariable, and OutVariable. For more
information, see about_CommonParameters, available from
the Microsoft website.

See ddve-installer-sc-help.text for additional information.

Installing the DDVE on Hyper-V using the GUI

You can use the New Virtual Machine wizard to install and configure the DDVE instance on a Hyper-V server.

Steps

1. From the Hyper-V Manager, select the Hyper-V server on which to deploy the new DDVE instance.

2. Launch the New Virtual Machine wizard.

3. Click Next to begin creating a DDVE virtual machine with a custom configuration.

4. On the Specify Name and Location page, specify a location for this virtual machine, enter a name for the new virtual
machine, and click Next.

5. On the Specify Generation page, select Generation 1.

6. On the Assign Memory page, enter the exact memory size (a multiple of 512 GB) required for the DDVE instance, and then
click Next.

Initial virtual machine configuration provides additional information.

7. On the Configure Networking page, select a configured virtual switch to attach to the new DDVE instance and click Next.
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8. For Connect Virtual Hard Disk, select an existing virtual hard disk and enter the path to the VHD file that you extracted
from the DDVE OS download.

9. Verify your configuration and select Finish.

10. On the Summary page, review your configuration and select Finish to deploy your new DDVE VM.
A successful completion message appears. For example, You have successfully completed the New Virtual
Machine Wizard. You are about to create the following virtual machine.

Configuring the DDVE on Hyper-V using the GUI

You can use the New Virtual Hard Disk wizard on Hyper-V to configure the newly installed DDVE instance.

Steps

1. After the DDVE virtual machine is deployed, it appears in the virtual machines list of the Hyper-V Manager.

2. Select the new DDVE virtual machine and select the Settings tab to configure the CPU, vNVRAM, and storage.

3. Select Add hardware > Processor and add the required amount of CPU for your DDVE capacity, and then click Apply.

Initial virtual machine configuration provides more information to help you make your selection

NOTE: Do not add any restrictions to CPU resources.

4. Add a 10 GB virtual disk for vNVRAM. All disks should be thick provisioned (lazy zero).

5. Select Add hardware, select the first SCSI controller under IDE controller 1, and click Add.

6. Select New Disk.

The New Virtual Hard Disk wizard opens as shown in the following figure.

7. Attach the first 10 GB virtual disk (vNVRAM) to the first SCSI controller under IDE controller 1. Ensure that vNVRAM is set
to location zero and click New to launch the disk configuration wizard.
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8. For Choose Disk Format, select VHDX.

9. For Choose Disk Type, select either Fixed, which offers the greatest performance, or Dynamically expanding, and then
click Next.

10. For Specify Name and Location, name the first disk as an vNVRAM disk to ensure that the vNVRAM disk resides on the
highest performing physical storage, and then click Next:

● Name—for example, NEW DDVE vnram.vhdx
● Location—D:\PremiumRAIDStorage\Hyper-V\Virtual Hard Disks\

11. For Configure Disk, select Create a new blank virtual hard disk. For Size enter 10 to create a 10 GB disk for vNVRAM
and click Finish.

12. On the Summary page, verify the configuration and click Next.

13. Add more virtual disks for backup data.

Use the same disk creation wizard to create up to 14 data disks for user data. Attach the data disks to the SCSI controller
beginning at location 1.

14. For Specify Name and Location, specify the name and location of the virtual hard disk file.

15. Select Create a new blank virtual hard disk and specify the Size as 500 GB.

Using several smaller disks can offer better overall performance than fewer larger disks.

You have created the minimum configuration for a functioning DDVE instance:
a. OS disk is attached at IDE controller zero.
b. vNVRAM disk is attached at the first SCSI controller : location zero.
c. Data storage disk is attached at first SCSI controller : location one.
d. For a larger capacity DDVE instance, you can add SCSI controllers, but doing so does not increase performance.

16. Select your new DDVE, click Start, and configure the new virtual machine as you would any other DD appliance.

Initial virtual machine configuration

Because the DDVE template does not include storage, you must add data disks to the system. Add the disks before you start
the virtual machine.

NOTE: You can add the first or additional virtual data disks while the virtual machine is running, provided that you do not

also need to add more virtual memory to support the additional disks. DDVE supports virtual disk hot-plugging, but does not

support CPU, memory, HBA card, or NIC card hot-plugging.

Depending on the amount of disk space you need, you might also need to add memory to the virtual machine. The following
table shows the supported storage configurations and their virtual CPU and memory requirements.
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An error message occurs if you attempt to configure a capacity with insufficient memory and CPU resources than required. The
system vresource show requirements command lists the virtual resources available on the host.

Table 11. Memory and CPU resource requirements 

Hardware configuration Storage capacity range (TB)

Up to 500 GB Up to 8 TB Up to 16
TB

Up to 32
TB

Up to 48
TB

Up to 64
TB

Up to 96
TB

CPU Topology 1 socket with 2 cores 1 socket with 4 cores 1 socket with 8 cores

Reservation 2 x 1.5 GHz 4 x 1.5 GHz 8 x 1.5 GHz

Memory Topology 8 GB 16 GB 24 GB 36 GB 48 GB 64 GB

Reservation

Adding NICs

When initially deployed, DD VE is provisioned with two VMXNET3 NICs which can be configured as required. Additional NIC
cards can be added up to a maximum of:

● DD VE NICs total

NOTE:

The following applies specifically to VMware:

● Additional NICs can only be of type VMXNET3. NICs of type VMXNET2 and E1000(E) can be added to the DD VE virtual

machine, but will not be visible or usable within DD OS on the appliance.

● DD VE does not support hot add of NICs. A VMXNET3 NIC can be added while DD VE is powered on, the NIC will not be

visible or useable within the DD OS on the appliance until the DD VE appliance is restarted.

● DD VE does not support hot remove of NICs. Any attempt to remove a NIC while the DD VE appliance is powered on

will cause ESXi/vSphere to report the following error: The guest operating system did not respond to
a hot-remove request for device ethernet3 in a timely manner.The DD VE appliance must
be powered off before NICs can be removed.

Setting up NTP time synchronization

About this task

NOTE: Skip this task if you are going to join the DDVE to an Active Directory domain. Because the Windows domain

controller obtains the time from an external source, NTP must be configured. See the cloud provider documentation on how

to configure NTP for the Windows operating system version or service pack that is running on your domain controller. After

joining the domain, the system time is periodically synchronized with the domain controller time. When the host joins the

Active Directory, the DDVE displays a warning if multiple time sources are in use.

Later, while performing initial configuration of the DDVE system, enable NTP by selecting the appropriate options from the
configuration wizards. If you do not use the wizards to perform initial configuration, you can use the ntp enable command on
the DD OS command line. Enabling NTP with the ntp enable command automatically disables synchronizing the time on the
guest to the host time.

To reenable synchronizing the guest time to the host time, run the ntp disable command.

.

Upgrading DD OS for DDVE

Use the RPM package file to upgrade the DD Operating System. The DD OS Administration Guide provides more information.

Use this procedure to upgrade the DDVE system for higher capacity.
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1. Shutdown the DDVE using the command system poweroff
2. Power on the DDVE instance.
3. Add the license for the new capacity.
4. Configure the newly added metadata disks using the CLI command storage add tier active dev<device ID>.

5. Expand the file system using the CLI command filesys expand.

Powering on the virtual machine

About this task

If the installation is successful, you can power on the DDVE virtual machine and log into the system.

Steps

1. From the hypervisor, power on the DDVE virtual machine.

NOTE: It might take several minutes for the DD OS prompt to appear.

2. Make note of the IP Address assigned to the system by DHCP.

You can use this address to configure or administer the system outside the hypervisor.

Next steps

Complete the initial system configuration in DD OS. The Data Domain Operating System Initial Configuration Guide provides
detailed instructions.

NOTE: To shut down the DDVE virtual machine, shut down the guest operating system from the DDSH with the command

system poweroff or system reboot. Do not reset or power off the DDVE virtual machine, because this action

performs a hard reset of the system rather than an orderly shutdown. Similarly, the Guest OS shutdown and Guest OS

reboot features in the hypervisor cannot guarantee an orderly shutdown and reboot.

Refer to the hypervisor documentation for additional information.

Defining the DD system information for your site
An installation requires information unique to your site. Before starting the installation, provide values for the system information
listed below.

NOTE: DD recommends that you print the tables in this section and record the information. Be sure to enter the serial

number correctly to avoid DDVE issues.

Table 12. System Setup Worksheet for DDVE  

Information Your Values

A unique VM name for the system:

The DNS domain name:

A default gateway IP address (if you are not using DHCP):

DNS server IP addresses (if you are not using DHCP):
● Primary
● Secondary
● Tertiary

If you will enable CIFS access, enter the information for your
CIFS authentication method:
1. For Workgroup authentication:

● Workgroup name:
● Backup user name:
● Password:
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Table 12. System Setup Worksheet for DDVE  (continued)

Information Your Values

2. For Active Directory authentication:
● Realm name:
● Domain admin name:
● Password

Host name from which to administer the system:

Administrator’s email address (or admin group alias):

Mail server (SMTP) host name:

Hypervisor server name:

(Optional) Physical location of the hypervisor server:

Region:
1. Zone
2. VPC
3. subnet

Serial number (SN) provided to you by DD:

Virtual machine unique ID (after initial configuration, use the
system show serialno command to display this ID):

Use this table to enter Ethernet connectivity information. By default, DHCP is enabled.

Table 13. Ethernet Connectivity Worksheet 

Ethernet
Connectivity

Enable Use DHCP IP Address (if no
DHCP)

Netmask (if no
DHCP)

ethV0

ethV1

ethV2

ethV3

ethV4

ethV5

ethV6

ethV7

Deploying DDVE on KVM hypervisor
You can run a DDVE instance as a virtual machine on top of the KVM hypervisor, which provides a full virtualization solution for
Linux.

Supported Linux distributions

DDVE on KVM only supports Intel-based processors. The following Linux distributions are supported by DDVE.

Linux distribution Version

CentOS 7-1611

Red Hat 7.2, 7.3

SUSE 12-SP2
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Linux distribution Version

Ubuntu 14.04 LTS Trusty, 16.04 LTS xenia

NOTE: Use the proper libvirt version provided by the supported Linux distributions. DDVE is supported on KVM libvirt

version 1.2.2 or later. The Ubuntu 16.04 distribution supports libvirt version 1.3.4.

Prerequisites

● Install the most recent version updates for your Linux distribution.
● Create a bridged network or open vSwitch for KVM.

Configuring other resources for DDVE on KVM
DEVE on KVM requires specific resource reservations and stream counts.

Resource reservations

Ensure that your system meets the resource reservations listed in the following table.

NOTE: Do not over commit CPU and memory resources on the KVM host with DDVE instances.

Table 14. DDVE resource reservations 

Resources Up to 8 TB Up to 16
TB

16 TB to
32 TB

Up to 48
TB

Up to 64
TB

Up to 96
TB

Computing
resources

CPU 2 x vCPU 4 x vCPU 8 x vCPU

Memory 8 GB 16 GB 24 GB 36 GB 48 GB 64 GB

Underlying
storage
requirements

Random IOPS 160 320 650 1280 1920 2560 3200

Random I/O
latency

14 ms

Sequential
throughput

40 MB/s 80 MB/s 160 MB/s 320
MB/s

480 MB/s 640 MB/s 960
MB/s

RAID RAID 5/6 or similar fault tolerance storage

SCSI controllers Virtio SCSI

vNVRAM
simulation file size

512 MB 1 GB 2GB

Configurations with DD Cloud Tier support has the same vNVRAM size as the
corresponding ones without DD Cloud Tier.

System disks ● 250 GB root disk
● 10 GB vNVRAM disk

NOTE: The root disk and vNVRAM disk are required to deploy the DDVE.

DDVE on KVM stream counts

Ensure that your system capacity meets the required stream counts listed in the following table.

Table 15. Stream counts for each capacity 

Configuration Write Stream Read Stream Repl Source Repl Dest Mixed Stream Max Mtree

8 TB 20 16 20 20 30 6
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Table 15. Stream counts for each capacity (continued)

Configuration Write Stream Read Stream Repl Source Repl Dest Mixed Stream Max Mtree

16 TB 45 30 45 45 60 6

32 TB 90 50 90 90 90 14

48 TB 90 50 90 90 90 14

64 TB 90 50 90 90 90 32

96 TB 180 50 90 180 180 32

Deploying the DDVE on the KVM Hypervisor
You can deploy the DDVE instance on KVM hypervisor.

Deploying DDVE on KVM using a reference script

The DD VE for KVM image contains reference scripts to deploy the DDVE image on KVM hypervisor and add the data disks
to a deployed DDVE. The scripts can be modified to run in your environment and are included in the tar.gz file that you
downloaded for the DDVE on KVM installation.

About this task

The script completes the following operations:

1. Generates the VM domain XML file config.xml.
2. Creates a new VM domain named ddve-test.

3. Converts the .qcow2 root disk in the tar.gz package to RAW format for better performance.

4. Attaches the root disk to SCSI 0:0.
5. Creates a 10 G raw disk named ddve-test-vnvram and attaches the disk to SCSI 0:1.

6. Sets up CPU and memory configuration for the DDVE virtual machine according to DDVE sizing guidelines.
7. Sets up network configuration for the DDVE instance.

a. Creates two virtual network interfaces.
b. Uses bridge as the interface type.

Steps

1. Extract the tar.gz file.

For example, tar -xvf ddve-kvm-0.6120.12.0-563880.tar.gz or tar -xvf ddve-kvm-0.6120.12.0-
xxxxxx.tar.gz where xxxxxx is the build number).

2. Change directory to the extracted folder.

3. To deploy a DDVE instance without data disks, run the script shown in the following example. The example creates a 16 TB
configuration DDVE instance with the name ddve-test on br0 network interface with the DDVE root disk and vNVRAM
disk on /kvm-root directory.

./kvm-ddve-installer.sh -n ddve-test -r /kvm-root -c 16TB -b br0
NOTE: [root@ddqa-r730-d05 ddve-kvm-6.1.2.5-595467]# ./kvm-ddve-installer.sh -h
Distribution: rhel Version:7.3. The host version check done. Basic Validation done. Usage: ./kvm-ddve-
installer.sh [options]

Where the options are:

● -n —Specify the virtual machine name (default will be the name of the DD VE build).

● -r —Specify the root disk full path (default will be the folder where installer script executed).

● -c —Specify the configuration 8TB, 16TB, 32TB, 48TB, 64TB, 96TB, Cloud16TB, Cloud64TB, and Cloud96TB.

● -b —Specify the bridge name (default will be br0).

● -p —Specify provision type for the data disk created on NFS. By default, the thin provisioning disk is created on NFS.

● -s —Specify the disk size in TB or GB (when option -s is specified, options -d and -x are mandatory).
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● -x —Specify the number of data disks (when option -x is specified, options -d and -s are mandatory).

● -d —Specify the path where the data disks will be stored (when option -s is specific, options -s and -x are mandatory).

● -w —Wait for IP address. The IP address of the DD VE will be displayed after deployment after a 5-minute wait for it to
become available.

● -h —Help message.

NOTE: Options –s, -x, and –d must be used as a set. If any of these options is used, the other two in the set are

required.

4. To deploy a DDVE instance with a data disk, run the script shown in the following example. The example creates a 4x4 TB
data disk on datastore1 along with the deployment of a 16 TB DDVE instance.

./kvm-ddve-installer.sh -n ddve-test -r /kvm-root -c 16TB -b br0 -x 4 -s 4TB -d /
datastore1

5. To add a data disk to the existing DDVE instance, run the script shown in the following example. The example creates a 4x2
TB data disk on datastore2 for the DDVE with the name ddve-8tb).

./kvm-add-disk.sh -n ddve-8tb -x 4 -s 2TB -d /datastore2
NOTE: kvm-ddve-installer.sh can only be run once per extraction, because it converts the qcow2 into raw

format. Any subsequent execution of the script will cause failures because qcow2 no longer exists.

Deploying the DDVE on KVM using the Virtual Machine Manager

The DDVE for KVM image deploys the DDVE image on the KVM hypervisor using virt-manager. Use this procedure to create a
DDVE virtual machine and configure the DDVE instance.

About this task

The example in this procedure deploys an 8 TB DDVE instance.

Steps

1. Create a DDVE virtual machine:

a. Open Virtual Machine Manager.
b. Select File > New Virtual Machine.
c. Select Import existing disk image > Forward.
d. Click Browse to select the root disk file.
e. Select Linux > Red Hat Enterprise Linux 6.4 > Forward.
f. Enter a name for the virtual machine, select Customize configuration before install, and click Finish.

2. Configure the DDVE instance:

a. In the left pane, select Processor, configure the following settings, and then click Apply:

● Current/Maximum allocation—2.
● Model—Hypervisor Default.
● Select Manually set CPU topology and set:

○ Sockets—1
○ Cores—2
○ Threads—1

b. Select Add Hardware > Controller, type SCSI and for Model, type VirtIO SCSI, and then click Finish.

c. Select Add Hardware > Network, configure the following settings, and then click Finish:

● Network source—Enter the bridge name on the host.
● Device Model—virtio.

d. Click Begin Installation.

Best Practices for deploying the DDVE on a KVM hypervisor

● Shut down the virtual machine before you make any changes to virtual machine settings with virsh edit. Some settings
do not take effect after a virtual machine restart but only after a virtual machine shutdown.
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● We recommend that you sync the KVM host to NTP. By default for DDVE on KVM, the KVM clock is enabled. Power on and
restart the system. The DDVE instance syncs with the KVM hypervisor.

● For the Ubuntu 16.04 distribution, update the libvirt package to version 1.3.4.

● Verify the directory permissions on the KVM host before trying to deploy the DDVE instance. If directory permissions
are incorrect, you might encounter these error messages: native: could not open disk image or Could not
open ... Permission Denied. When mounting to a remote directory, ensure that the directory permissions are
correct for both the qemu user and the current user during the deployment.

NOTE: The qemu user needs search permissions all the way up the path of the directory tree.

Creating a bridged network interface using Virtual Manager

Supported Linux distributions might use different configuration files and different commands in the command line interface
(CLI). To use the CLI, refer to the Linux vendor documentation for your Linux distribution for additional information.

About this task

By default, KVM uses Usermode Networking, where NAT is performed on traffic through the host interface to the outside
network. A DDVE best practice is to use a Bridge Network, which allows external hosts to access the guest virtual machine
directly. Guest virtual machines are connected directly to the host network.

Steps

1. Verify that the bridging kernel is installed by running this command: modprobe --first-time bridge
An error message should appear stating that the module is already in the kernel.

2. Use the GUI or CLI commands to find the name of the physical interface on your host. Verify that it is physically connected
and functional.

This interface is used in the network bridge. You can use the following CLI commands:
● ifconfig - lists the interfaces on the host.

● ethtool <int name> - displays details about the interface .

3. Open the Virtual Manager (virt-manager).

4. Click Edit > Connection Details > Network Interfaces.

5. On the QEM/KVM Connection Details screen, click the plus button (+) at the bottom of the screen to start the Add
interface wizard.

6. On the Configure Network Interface screen in the Interface type list, ensure that Bridge is selected, and then click
Forward.

7. Ensure that the bridge interface name is br0 and from the Start mode list, select Onboot.

8. Verify that the bridge interface has the correct IP address settings. To change the IP settings click Configure.

9. On the IP Configuration screen, click through the IPv4 and the IPv6 tabs to configure the settings, and then click OK.

You can configure the bridge interface to pick up the IP address from DHCP or you can statically configure the IP address if
you know the network settings.

10. Click Configure for the bridge settings.

11. Clear the Enable STP check box, and then click OK.

12. Select the physical interface that will be a member of this bridge, ensure that only one interface is selected, and then click
Finish.

13. Reboot or restart the network services:

systemctl restart network

14. Verify that the bridge interface is running:

ifconfig br0

15. You can also verify the bridge interface in the virt-manager GUI: Click Edit > Connection details > Network interaces >
br0.
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Results

The connection is complete.
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Completing Initial DDVE Configuration
This chapter includes the following topics:

Topics:

• Initial System Configuration
• Monitoring performance
• Configuring other resources
• Configuring optional software and internal licenses
• Configuring optional system settings

Initial System Configuration
You can connect to the system to perform the initial system configuration with the DDSM Configuration Wizard or manually
using the CLI.

DHCP is enabled on the DDVE system by default. If the DHCP service is available, the DDVE system will receive IP addresses
from the DHCP server.

NOTE: DHCP is only activated automatically for the first network interface card (NIC) which is built into the virtual

machine template. Any extra NICs must be configured manually by following instructions here https://docs.microsoft.com/

en-us/azure/virtual-network/virtual-network-network-interface-vm.

Using the CLI

Access the CLI by using ssh or a terminal emulator to access the DD OS command line. The CLI configuration utility contains
four sections: Network, eLicense, System, and DD Boost.

Using the GUI

Access DDSM by entering the IP address of the DDVE into a web browser, and logging in. The GUI Configuration Wizard
contains six sections: Networking, File System, System Settings, DD Boost, CIFS, and NFS.

Completing Initial Configuration with the Command-Line on page 34 describes how to configure the DDVE manually with the
CLI instead of using the configuration utility.

DDVE storage guidelines

Be aware of the following virtual storage guidelines for DDVE before deploying a DDVE instance.

DDVE licenses are sold in Terabytes (TB), but VMware disk sizes are actually measured in Tebibytes (TiB). 1 TB is equal to 0.97
TiB or 1.02 TB is equal to 1 TiB. Because of this, DDVE allows a 10% buffer to reach the licensed capacity measured in TB.
Additionally, Hyper-V manager also uses GiB for "GB" in its GUI.

Table 16. TB to TiB equivalents 

Licensed capacity in TB Licensed capacity in TiB Maximum capacity with buffer in TB

8 TB 7.3 TiB 8.8 TB

16 TB 14.6 TiB 17.6 TB

32 TB 29.2 TiB 35.2 TB

3
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Table 16. TB to TiB equivalents (continued)

Licensed capacity in TB Licensed capacity in TiB Maximum capacity with buffer in TB

48 TB 43.8 TiB 52.8 TB

64 TB 58. 4 TiB 70.4 TB

96 TB 87.6 TiB 105.6 TB

Individual virtual disks are subject to overhead that reduce their amount of usable capacity to amounts lower than their specified
capacity.

● The first data disk is subject to 120 GB of base overhead, with 5.6% of the remaining capacity reserved for RAID-on-LUN
● All subsequent data disks are subject to 5.6% overhead reserved for RAID-on-LUN

Table 17. Virtual disk overhead calculations 

Disk Overhead calculation Usable capacity examples

First data disk (200 GB or more) (Total capacity - 120 GB) * 0.944 ● 200 GB disk: 75.5 GB
● 300 GB disk: 169.9 GB
● 400 GB disk: 264.3 GB
● 500 GB disk: 358.7 GB

All subsequent data disks (100 GB or
more)

Total capacity * 0.944 ● 100 GB disk: 94.4 GB
● 200 GB disk: 188.8 GB
● 300 GB disk: 283.2 GB
● 400 GB disk: 377.6 GB
● 500 GB disk: 472 GB

Configuring DDVE in DD System Manager

DDVE licensing and configuration can be accomplished through the Configuration Wizard in DD System Manager. After the initial
installation of a DDVE instance, the Configuration Wizard automatically appears after the licensing screen on the first launch of
DDSM.

NOTE: The DAT is not supported for cloud DDVE.

Enter the DDVE virtual machine IP address into a web browser to launch DD System Manager. Log in with the following
credentials:

● Username: sysadmin
● Password: changeme

DDVE licensing

The Apply Your License window is the first screen that appears when DDSM is launched for the first time. The DDVE instance
is locked until a license file is applied.

Click Browse, locate the license file for a purchased capacity license or the evaluation license included with the DDVE
download, then click Apply.

NOTE: The DDVE pre-installed evaluation license provides 45 days of limited access to DDVE software for evaluation

purposes and may only be used in a non-production environment. If you begin the configuration with the evaluation license,

but wish to purchase a license later, you will need the Node Locking ID for the DDVE instance. Click Administration >

Licenses to view the Node Locking ID.
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Figure 1. DDVE Node Locking ID

NOTE: When you obtain the original license file name from the server, do not enter the comma in the license file name. DD

OS will not accept the name if the comma is used.

DDVE configuration

After applying the DDVE license, the Configuration Wizard begins automatically. The wizard assists in configuring the following
aspects of the DDVE:

● Networking
○ DHCP or manual settings
○ Virtual interface ethV0 and ethV1 configuration
○ DHCP or manual DNS configuration

Figure 2. Configuration Wizard - Network
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● File system
NOTE: DDVE supports a maximum of six MTrees active at a given time, however up to 100 MTrees can be created on

DDVE.

○ Create virtual storage devices
○ Optionally enable the DDFS automatically after creating it

Figure 3. Configuration Wizard - File System
● System settings

○ Update the sysadmin password
○ Optionally configure alert and autosupport email settings

Figure 4. Configuration Wizard - System Settings
● DD Boost

○ Create a Boost storage-unit, and assign a user ID to own it
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Figure 5. Configuration Wizard - DD Boost Protocol

Provisioning the storage with the CLI

Provision virtual disks using the command line interface (CLI).

Steps

1. Log into the system as sysadmin.

The default password is changeme.

At the first login, use the elicense command to add a DDVE license.

2. Press Ctrl-C to exit the configuration utility.

3. Confirm that virtual disk dev3 exists and has the expected size:

# disk show hardware
The output should include a line similar to the following example:

dev3 VMware Virtual disk 1.0 (unknown) 256.00 GiB SAS n/a
The virtual disks (dev1 and dev3) are used for the system software and cannot be used for storage. The disk show
state command shows System Dev for these system disks.

4. Optional: Run DAT tool test:

● Start DAT tool test: # disk benchmark start dev3
● Monitor the test progress: # disk benchmark watch
● View test results: # disk benchmark show

5. Add the storage disk to the active storage tier:
# storage add dev3
If you are adding more than one virtual disk, repeat the storage add command for each disk.

6. Create the file system:

# filesys create
The filesys create command might take longer to complete if the hypervisor's storage is slow and does not meet the
minimum recommendations.

7. Enable the file system:

# filesys enable
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Next steps

Complete the initial system configuration. See Completing Initial Configuration with the Command-Line.

Completing Initial Configuration with the Command-Line

About this task

Follow the configuration utility instructions for entering appropriate values. At the end of each configuration section, you can
Save, Cancel, or Retry (restart the input entry at the beginning of the current section).

At each prompt, you can:

● Enter a value
● Enter a question mark (?) for more details
● Press Enter to accept the value displayed in braces.

The utility accepts list entries that are comma-separated, space-separated, or both.

NOTE: You can enable NTP using the configuration utility.

Steps

1. Enter the config setup command to start the configuration utility.

2. Prompts guide you through configuring the following parameters:

● System name
● System domain name
● Initial IP port—Select DHCP or enter a static IP address and Net Mask.

3. At the prompt, do one of the following:
● Exit the configuration utility and continue configuring the system using the GUI
● Continue using the CLI configuration utility.

Configuring the system for data access

If you did not configure data access with the configuration wizard, use the procedures referenced in this section to configure
one or more protocols.

Depending on your environment, you must configure one or more protocols and clients for data access. Clients enable access
to the DDVE system with the configured protocol. The DDVE system provides the DD Boost protocol for cloud or on-premises
systems.

● DD Boost—For setting up the DD Boost feature, see the DD Boost for Open Storage Administration Guide or DD Boost for
Partner Integration Administration Guide, available at https://support.emc.com.

● Application integration—For information about how to integrate the DD system with backup software, see the
documentation for the applicable application at the DD Integration Documentation section on the DD Support web site
https://support.emc.com.

Monitoring performance
Use the performance monitoring feature of DDVE to troubleshoot issues.

Dell EMC recommends that you enable the performance monitoring features of the DDVE instance, which enable you to detect
performance problems on the physical storage layer.

The system provides a deployment assessment tool (DAT) which runs on DDVE. It measures the underlying I/O performance
and determines the size of the file system. You can use DAT to scan the available physical storage to determine if the storage
meets DDVE requirements. DDVE resource reservations on page 35 lists the required physical storage specifications for DDVE.
You can access the DAT using the CLI or from the DDVE GUI console.

DDVE provides DAT testing for the Boost protocol only and will skip vNVRAM values to enhance DDVE performance.

NOTE: Use the with-vnvram option if you are using NFS to write backups.

34 Completing Initial DDVE Configuration

https://support.emc.com
https://support.emc.com


Configuring other resources
This section discusses resources other than storage.

CPU resources

For VMware environment, Initial virtual machine configuration on page 20 lists the CPU requirements.

For a Windows environment, the CPU reservation is configured as a percentage. Virtual Machine Reserve should be set to
100%.

NOTE: Do not reduce system memory after you have created the file system in DD OS. Reducing memory makes the file

system unusable.

Network adapters

DDVE can support up to eight virtual network adapters.

For VMware environments, the OVA package creates two VMXNET3 virtual network adapters by default. DHCP is configured
automatically on these two interfaces within DDVE. You can configure DHCP manually on any additional interfaces.

For Windows environments, DHCP is configured automatically for up to two network interfaces. You can configure DHCP
manually on any additional interfaces.

Disk controllers

For VMware environments, DDVE supports up to four VMware Paravirtual SCSI Controllers. Other types of SCSI controllers are
not supported.

For Windows environments, DDVE supports up to four Microsoft SCSI controllers.

One SCSI Controller is configured by default. The maximum number of disks for each controller is 15 for vSphere and 64 for
Hyper-V. If the environment requires more than the maximum number of disks, you can add SCSI HBA controllers to the DDVE
system, but do not change the HBA controller type from the type of the first HBA controller. If you make changes accidentally,
power off the virtual machine and restore the original settings.

VMware resource pools and vApp containers

If you add DDVE systems to resource pools or vApp containers, do not override the default memory and CPU resource allocation
settings. If the DDVE virtual machine does not meet the minimum resource requirements, it fails to start and reports an
insufficient resource message. The following table lists the minimum resource requirements.

If you attempt to configure a higher capacity with fewer memory and CPU resources than the minimum requirements, the
system displays an error message. To check the settings, in the vSphere Client open the Resources tab of the Virtual
Machine Properties dialog box or use the system vresource show requirements command.

Table 18. DDVE resource reservations 

Resources Up to 8 TB Up to 16
TB

16 TB to
32 TB

Up to 48
TB

Up to 64
TB

Up to 96
TB

Computing
resources

CPU 2 x GHz vCPU 4 x GHz vCPU 8 x GHz vCPU

Memory 8 GB 16 GB 24 GB 36 GB 48 GB 64 GB

Shares Normal

Limit Unlimited

Underlying
storage
requirements

Random IOPS 320 650 1280 1920 2560 3200

Random I/O
latency

14 ms
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Table 18. DDVE resource reservations (continued)

Resources Up to 8 TB Up to 16
TB

16 TB to
32 TB

Up to 48
TB

Up to 64
TB

Up to 96
TB

Sequential
throughput

80 MB/s 160 MB/s 320
MB/s

480 MB/s 640 MB/s 960
MB/s

RAID RAID 5/6 or similar fault tolerance storage

SCSI controllers For Hyper-V and ESX: Up to 4 SCSI controllers. For KVM: Virtio SCSI.

vNVRAM
simulation file size

512 MB 512 MB 1 GB 1 GB 1 GB 2GB

Configurations with DD Cloud Tier support has the same vNVRAM size as the
corresponding ones without DD Cloud Tier.

System disks ● 250 GB root disk
● 10 GB vNVRAM disk

NOTE: The root disk and vNVRAM disk are required to deploy DDVE.

Data disks ● The minimum first data disk size: 500GiB for 64TB, Cloud 64TB, 96TB, and Cloud
96TB; 200GiB for all other configurations

● All subsequent data disks: at least 100 GB
Whenever possible, use disks that are larger than the minimum required disk sizes.
The maximum capacity of DDVE is defined by the DDVE license, and the maximum
virtual disk size supported by the hypervisor.

NOTE: The usable capacity available on a data disk is less than the capacity
specified when the disk was created because of overhead requirements. DDVE
storage guidelines on page 29 provides additional details about DDVE storage
overhead requirements.

Network adapters Up to 8 network adapters

Configuring optional software and internal licenses
If you need to configure optional software features, you must install and activate the appropriate licenses before you configure
those features. See Introducing DDVE on page 7 for information about features and licenses that are available to for DDVE.

A separate license is required for DD Cloud Tier.

The DD OS Administration Guide provides information about installing licenses and configuring optional software. Refer to
the applicable DD OS Release Notes for the most up-to-date information on product features, software updates, software
compatibility guides, and information about our products, licensing, and service. Access the latest documents at https://
support.emc.com.

Configuring optional system settings
See the DD Operating System Initial Configuration Guide for help performing typical but optional initial system configuration
tasks. The following table provides a summary of the DD OS CLI commands for some common tasks.

NOTE: Any system command that accepts a list, such as a list of IP addresses, accepts entries separated by either commas

or spaces. The DD Operating System Command Reference Guide provides command details.

Task Command

Add users to the email list that reports system problems # alerts notify-list add group-name
Add users to the system report email list # autosupport add {alert-summary|asup-detailed}

emails email-list
Enable FTP or TELNET # adminaccess enable {ftp|telnet}
Add remote hosts to use FTP # adminaccess ftp add <host list>
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Task Command

Add a user # user add name [role {admin|user}]
Change a user’s password # user change password username
Shut down the system # system poweroff

The DD Operating System Administration Guide provides details about enabling remote management.
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Administering DDVE
This chapter includes the following topics:

Topics:

• Adding virtual storage
• Extensions to DDOS for DDVE
• DDVE-only commands
• Modified DD OS commands
• Unsupported DD OS commands
• Troubleshooting performance issues

Adding virtual storage
Additional virtual storage can be added to the DDVE using the GUI or the CLI.

NOTE: DDVE does not support the use of VMware RDM volumes.

NOTE: It is not possible to extend a virtual disk if it has already been used by the file system. Instead, expand the storage

by adding a new virtual disk.

Using the GUI

In DD SM, click Hardware > Storage > Configure Storage to add the additional devices to the DDVE active tier.

After adding the storage, click Data Management > File System > Expand Capacity > Next to launch the DAT to verify the
hardware supporting the virtual storage meets the requirements for DDVE.

Using the CLI

When you add a new virtual data disk to an existing DDOS file system, use the filesys expand command instead of the
filesys create command. For instructions and restrictions, see Initial Virtual Machine Configuration with the vSphere
Client.

Extensions to DDOS for DDVE
Several DDOS commands are supported on the DDVE platform only. This section describes these commands.

Storage performance evaluation

Manage virtual disk performance benchmark tests.

Storage performance can be evaluated in two ways:

● With the DAT in DDSM
● With the disk benchmark command in the DD OS CLI

4
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DAT

In addition to being part of the DDSM Configuration Wizard, DAT can be run as part of the process of adding new devices to
expand the file system on the DDVE instance.

NOTE: Running DAT before expanding the file system requires the presence of at least one device to add to the active

storage tier. Also, benchmark should not be run when virtual disks are absent.

In DDSM, click Data Management > File System > Expand Capacity.

Click Configure to add devices to the active tier, or click Next if you have already added the devices to the active tier.

Run the DAT to analyze the underlying storage performance.

disk benchmark

disk benchmark requirements
Displays the currently configured recommended performance characteristics by disk capacity.

disk benchmark start <dev-list>
Start a performance benchmark test on one or more data disks in series or in parallel.

● Specify dev[3-5]+dev7+dev[10-12] to test the specified devices in sequence, one after the other.

● Specify dev(3-5) dev7 dev(10-12) to test the specified devices in parallel.

Test dev3. When that test finishes, test dev4.

# disk benchmark start dev[3-4]
Test dev3 and dev4 in parallel.

disk benchmark start dev(3-4)
Start two series of tests in parallel. The two series of tests are dev3 followed by dev4, and dev5 followed by dev6.
# disk benchmark start dev(3-4) dev(5-6)
disk benchmark show {[[detailed] test-id] | all | requirements}
Print disk performance benchmark test results and report a recommended capacity for the tested configuration. With no
arguments, the command prints information about the most recent test for every disk. Specify a test-id to see information
about a single test. Specify all to see a table of previous and currently running tests. Specify requirements to see a table
of performance goals.

NOTE: The disk benchmark show command shows the results of the test of storage performance on the host system

to determine which DDVE capacity configurations can be supported on the host.

disk benchmark start
Conducts a test of storage performance.

disk benchmark stop
Stop all running tests.

disk benchmark watch
Display the ongoing results of all tests in progress.

disk benchmark (for SSD cache performance)

disk benchmark start <dev-list> cache <dev-list>
Start a performance benchmark test on one or more cache devices. Where cache <dev-list> is an optional argument.

NOTE: The <dev-list> argument for cache devices is listed in parallel. Serial testing of cache devices is restricted, and not

supported.

Cache device in parallel (supported):
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# disk benchmark start dev5+dev6+dev7 cache dev3:dev4
Cache device in serial (not supported):

# disk benchmark start dev5+dev6+dev7 cache dev3+dev4
# disk benchmark show requirements <cache>
Displays the currently configured recommended performance characteristics for cache capacity. Where <cache> is an optional
argument.

perf

Collect and show DDVE performance statistics.
perf disable trace event-regexp [module {default | ddfs}]
Disable tracing of specified events.

perf enable trace event-regexp [module {default | ddfs}]
Enable tracing of the specified events.

perf start histogram [module {default | ddfs}
Start collecting performance histograms. This command may reduce performance marginally.

perf start stats
Start printing statistics. This command may reduce performance marginally.

perf start trace [allow-wrap] [module {default | ddfs}]
Start tracing events. This command may reduce performance marginally.

perf status trace event-regexp [module {default | ddfs}]
Shows whether tracing is enabled or disabled for the specified events.

perf stop histogram histogram-filename [module {default | ddfs}
Stop collecting histograms and write the collected histograms to the specified file.

perf stop stats
Stop printing statistics.

perf stop trace trace-filename [module {default | ddfs}]
Stop tracing events and write the collected traces to the specified file.

system vresource

Display details about the virtual CPU and memory resources on the DDVE.
system vresource show [current | requirements]

sysadmin@zx-benmark-1# system vresource show requirements
  Active Tier      Cloud Tier                                        Instance
Capacity (TB)   Capacity (TB)                                            Type
-------------   -------------   ---------------------------------------------
            8             n/a   Standard_F4 (Only block storage is supported)
           16             n/a                                     Standard_F8
           32             n/a                                  Standard_D4_v2
           96             n/a                                 Standard_D16_v3
          256             n/a                                Standard_D32s_v3
-------------   -------------   ---------------------------------------------
** The maximum allowed system capacity for active tier on block storage is 16 TB
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DDVE-only commands
The following commands only work on DDVE, and are not supported on physical DD systems.

Table 19. DDVE-only commands 

Command Description

elicense checkout feature-license <feature-
name-list>

Allows user to check out the features of licenses for License
Server installation

elicense checkout capacity-license <feature-
name> value <n> {TB|GB}

Allows user to check out the capacity of licenses
for License Server installation. Here is sample output:
sysadmin@localhost# elic checkout capacity-
license capacity value 10 TB Checking
out CAPACITY license willl also checkout
available feature licenses. An addition 10
TB CAPACITY license will be checked out.
10 TB additional CAPACITY license has been
checked out. License(s) have been checked
out for REPLICATION, DDBOOST, ENCRYPTION.
Total 10 TB CAPACITY license is now
available on this system.

elicense checkin {<feature-name-list>| all} Allows user to check in features for licences for License
Server installation

elicense license-server set server {<ipaddr>
| <hostname>} port <port-number>
elicense license-server reset Returns DDVE to factory license settings.

elicense license-server show
filesys show space tier active local-
metadata

Displays the usage for the metadata storage.
NOTE: Some portion of the disk space is reserved for
internal metadata, such as index. The amount of space is
based on the maximum capacity of the platform and not
on licensed capacity.

net hosts add Two DDVEs in different regions cannot resolve each other's
hostname. Run this command to add a host list entry.

NOTE: For VNET to VNET connection between different
regions in Azure, see Microsoft.com.

storage object-store enable Enables the object-store feature for DDVE.

storage object-store disable Disables the object-store feature for DDVE.

storage object-store profile set Configures the object-store access profile.

storage object-store profile show Displays the object-store access profile.

storage object-store profile status This CLI lists the object-store profile information set on the
DDVE.

system vresource show [requirements] Displays the file system capacity, the number of virtual CPUs,
and the amount of memory assigned to the virtual machine
running the DDVE instance. The requirements option
displays the physical storage requirements
for DDVE.

vserver config set DDVE supports the hypervisor's functionality to collect
performance statistics from the hypervisor. These
performance statistics can be used to troubleshoot the DDVE
performance problems. To do that, users need to specify
the vServer information (hostname or IP address) and the
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Table 19. DDVE-only commands (continued)

Command Description

credential information(username and password). The vServer
can be a vCenter server, an ESXi host for vSphere, a
Hyper-V server, or an SVCMM server for Hyper-V. Once
this information is configured, DDVE will collect performance
statistics from the vServer every 5 minutes.

vserver config reset Reset the vServer credentials for DDVE to their default
values.

vserver config show Display the vServer credentials for DDVE.

Modified DD OS commands
The behavior of the following commands has been modified on the DDVE platform:

Table 20. Modified DD OS commands 

Command Changes

alert The tenant-unit parameter is not supported.

compression The tenant-unit parameter is not supported.

config setup show Arguments for configuring features not available in DDVE have
been removed.

ddboost clients show active The tenant-unit parameter is not supported.

ddboost file-replication show active The tenant-unit parameter is not supported.

ddboost file-replication show detailed-file-
history

The tenant-unit parameter is not supported.

ddboost file-replication show file-history The tenant-unit parameter is not supported.

ddboost option reset The fc parameter is not supported.

ddboost option show The fc parameter is not supported.

ddboost storage-unit create The tenant-unit parameter is not supported.

ddboost storage-unit modify The tenant-unit parameter is not supported.

ddboost storage-unit show The tenant-unit parameter is not supported.

ddboost streams show active The tenant-unit parameter is not supported.

ddboost streams show history The tenant-unit parameter is not supported.

disk rescan The <enlcosure-ID>.<disk-ID> parameter is not
supported.

disk show state DDVE system disks show the System Dev state.

disk show stats The DDVE format for this command is disk show stats
[dev <n>]

disk status The Spare row has been removed from the output. The
System row has been added.

enclosure show all The [<enclosure>] parameter is not supported.

enclosure show controllers The [<enclosure>] parameter is not supported.

enclosure show cpus The [<enclosure>] parameter is not supported.

enclosure show io-cards The [<enclosure>] parameter is not supported.
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Table 20. Modified DD OS commands (continued)

Command Changes

enclosure show memory The [<enclosure>] parameter is not supported.

filesys encryption keyes delete The [tier {active | archive} | archive-unit
<unit-name>] parameter is not supported.

filesys encryption keys show The [tier {active | archive} | archive-unit
<unit-name>] parameter is not supported.

filesys fastcopy The [retention-lock] parameter is supported with DDVE
4.0. Retention lock governance mode is supported for DDVE
on premises. Retention lock compliance mode is not supported
for any DDVE.

filesys show compression The [tier {active | archive} | archive-unit
<unit-name>] parameter is not supported.

filesys show space The [tier {active | archive} | archive-unit
<unit-name> | arcjove-unit {all | <unit-
name>] parameter is not supported.

mtree create The tenant-unit parameter is not supported.

mtree list The tenant-unit parameter is not supported.

mtree show compression The tenant-unit and tenant-unit parameters are not
supported.

mtree show performance The tenant-unit parameter is not supported.

net create interface The <virtual-ifname> parameter is not supported.

net destroy The <virtual-ifname> parameter is not supported.

perf The vtl option is not supported on any perf command.

storage add The enclosure and disk parameters are not supported.

storage remove The enclosure and disk parameters are not supported.

storage show The archive option is not supported.

system show stats NVRAM statistics are not reported, because DDVE systems
do not have physical NVRAM.

quota The tenant-unit parameter is not supported.

replication MTree replication is the only type of replication supported.

snapshot The tenant-unit parameter is not supported.

Unsupported DD OS commands
The following DD OS commands and command options are not supported on the DDVE platform.

Table 21. Unsupported commands and command options 

Unsupported command or command option Notes

adminaccess https generate certificate Deprecated. Use adminaccess certificate generate
instead.

alerts add Deprecated. Use alerts notify-list add instead.

alerts del Deprecated. Use alerts notify-list del instead.
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Table 21. Unsupported commands and command options (continued)

Unsupported command or command option Notes

alerts notify-list option set group-name
tenant-alert-summary {enabled | disabled}
alerts notify-list option reset group-name
tenant-alert-summary
alerts reset Deprecated. Use alerts notify-list reset instead.

alerts show alerts-list Deprecated. Use alerts notify-list show instead.

alerts test Deprecated. Use alerts notify-list test instead.

archive
authorization
autosupport display Deprecated. Use autosupport show report instead.

autosupport reset support-list Deprecated. Use autosupport reset { all | alert-
summary | asup-detailed | support-notify }
instead.

autosupport show support-list Deprecated. Use autosupport show { all | asup-
detailed | alert-summary | support-notify }
instead.

cifs set authentication nt4 Deprecated. Use cifs set authentication active-
directory instead.

cluster
ddboost fc
ddboost option reset fc
ddboost option set distributed-segment-
processing disabled

Turning off distributed segment processing (DSP) with this
DDBoost command is not supported for DDVE on DD OS
6.1.2.x.

ddboost option show Turning off DSP with this DDBoost command is not supported
for DDVE on DD OS 6.1.2.x.

ddboost option show fc
ddboost show image-duplication Deprecated. Use ddboost file-replication show

instead.

ddboost user option set user default-tenant-
unit tenant-unit
ddboost user option reset user [default-
tenant-unit]
disk add devdisk-id [spindle-group 1-16] Deprecated. Use storage add instead.

disk add enclosure enclosure-id Deprecated. Use storage add instead.

disk benchmark start Not supported by DDVE in cloud

disk benchmark show Not supported by DDVE in cloud

disk benchmark stop Not supported by DDVE in cloud

disk benchmark watch Not supported by DDVE in cloud

disk expand Deprecated. Use storage add instead.

disk failenclosure-id.disk-id
disk multipath
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Table 21. Unsupported commands and command options (continued)

Unsupported command or command option Notes

disk port
disk rescan [enclosure-id.disk-id]
disk show detailed-raid-info Deprecated. Use disk show state and storage show

instead.

disk show failure-history
disk show performance Not supported by DDVE in cloud

disk show raid-info Deprecated. Use disk show state and storage show
instead.

disk show reliability-data
disk disk show stats Not supported by DDVE in cloud

disk unfail
enclosure beacon
enclosure show all [enclosure] This command is supported, but not with the enclosure

argument.

enclosure show chassis
enclosure show controllers enclosure This command is supported, but not with the enclosure

argument.

enclosure show cpus [enclosure] This command is supported, but not with the enclosure
argument.

enclosure show fans
enclosure show io-cards [enclosure] This command is supported, but not with the enclosure

argument.

enclosure show memory [enclosure] This command is supported, but not with the enclosure
argument.

enclosure show nvram
enclosure show powersupply
enclosure show summary
enclosure show temperature-sensors
enclosure show topology
enclosure test topology
filesys archive
filesys clean update-stats Deprecated. Use filesys show space instead.

filesys encryption
filesys encryption passphrase change Deprecated. Use system passphrase change instead.

filesys retention-lock Deprecated. Use mtree retention-lock instead.

filesys show compression tier The tier option is not supported.

filesys show history Deprecated. Use filesys show compression daily
instead.

ha create Not supported by DDVE in cloud

ha destroy Not supported by DDVE in cloud
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Table 21. Unsupported commands and command options (continued)

Unsupported command or command option Notes

ha status Not supported by DDVE in cloud

ha failover Not supported by DDVE in cloud

ha online Not supported by DDVE in cloud

ha offline Not supported by DDVE in cloud

license The license commands are not supported because DDVE
uses new elicense commands.

mtree show compression mtree_path tier
net aggregate
net config ifname type cluster
net create interface virtual-ifname
net create interface physical-ifname vlan
vlan-id

net create virtual vethid
net destroy virtual-ifname
net destroy vlan-ifname
net failover
net modify virtual-ifname bonding {aggregate
| failover
net set portnaming
ndmp
ndmpd
nfs option disable report-replica-as-
writable

Deprecated. Use filesys option disable report-
replica-as-writable instead.

nfs option enable report-replica-as-writable Deprecated. Use filesys option enable report-
replica-as-writable instead.

nfs option reset report-replica-as-writable Deprecated. Use filesys option reset report-
replica-as-writable instead.

nfs option show report-replica-as-writable Deprecated. Use filesys option show report-
replica-as-writable instead.

perf * module vtl
san
shelf migration start Not supported by DDVE in cloud

shelf migration status Not supported by DDVE in cloud

shelf migration suspend Not supported by DDVE in cloud

shelf migration resume Not supported by DDVE in cloud

shelf migration precheck Not supported by DDVE in cloud

shelf migration option Not supported by DDVE in cloud

shelf migration finalize Not supported by DDVE in cloud

shelf migration show history Not supported by DDVE in cloud
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Table 21. Unsupported commands and command options (continued)

Unsupported command or command option Notes

snapshot add schedule name [days days] time
time [,time...] [retention period]

Deprecated. Use snapshot schedule create instead.

snapshot add schedule name [days days] time
time every mins [retention period]

Deprecated. Use snapshot schedule create instead.

snapshot add schedule name [days days] time
time-time [every hrs | mins] [retention
period]

Deprecated. Use snapshot schedule create instead.

snapshot del schedule {name | all} Deprecated. Use snapshot schedule destroy instead.

snapshot modify schedule name {[days days] |
time time [,time...] | [retention period]}

Deprecated. Use snapshot schedule modify instead.

snapshot modify schedule name {[days days] |
time time every {mins | none} | [retention
period]}

Deprecated. Use snapshot schedule modify instead.

snapshot modify schedule name {[days days] |
time time-time [every {hrs | mins | none}] |
[retention period]}

Deprecated. Use snapshot schedule modify instead.

snapshot reset schedule Deprecated. Use snapshot schedule reset instead.

snapshot show schedule Deprecated. Use snapshot schedule show instead.

storage add enclosure enclosure-id
storage add disk enclosure-id.disk-id
storage remove enclosure enclosure-id
storage remove disk enclosure_id.disk-id
system firmware
system option set console
system retention-lock
system sanitize
system show anaconda
system show controller-inventory
system show nvram
system show nvram-detailed
system show oemid
system upgrade continue
user
user change priv Deprecated, with no replacement.

vserver config set host Not supported by DDVE in cloud

vserver config reset Not supported by DDVE in cloud

vserver config show Not supported by DDVE in cloud

vserver config perf-stats start Not supported by DDVE in cloud

vserver config perf-stats stop Not supported by DDVE in cloud

vserver config perf-stats status Not supported by DDVE in cloud

vtl lunmask Deprecated. Use vtl group instead.
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Table 21. Unsupported commands and command options (continued)

Unsupported command or command option Notes

vtl lunmask add Deprecated. Use vtl group add instead.

vtl lunmask del Deprecated.

vtl lunmask show Deprecated. Use vtl group show instead.

Troubleshooting performance issues
You can check DDVE performance statistics as follows:

● With the native tools available in VMware vCenter or ESXi, or Microsoft Hyper-V.

You can also use the following to monitor benchmark performance:

● perf show
● disk benchmark
Extensions to DDOS for DDVE on page 38 provides more information about commands.

CPU Performance

The two key statistics for CPU performance are:

● CPU usage—CPU usage as a percentage during the interval
● CPU ready—The percentage of time that the virtual machine was ready, but could not get scheduled to run on the physical

CPU. This counter might not be displayed by default.

If these counters are high, there may be a performance problem on the hypervisor host.

Memory Performance

● Memory swapping—The key statistic for memory performance, which is the current amount of guest physical memory
swapped out to the virtual machine’s swap file.

● The memory swapping value should always be zero. If it is not, there is a memory resource contention on the hypervisor
host, which is likely to have a severe impact on DDVE performance.

Virtual Disk Performance

The key statistics for virtual disk performance are:

● I/O throughput—A decrease in these values indicates a performance issue.
● I/O latency—An increase in read and write latency values indicates a performance problem.
Failed commands—An increase in the average number of outstanding read and write requests indicates a performance problem.

NOTE: The controls and names for these statistics and counters might be different in some versions of the vSphere Client

and between VMware and Microsoft hypervisors. See your hypervisor documentation for help displaying these statistics in

your environment.
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